Beginner’s Guide to SolidWorks 2007

Alejandro Reyes, MSME
Certified SolidWorks Professional and Instructor

Schroff Development Corporation
www.schroff.com
www.schroff-europe.com
Part Modeling

The design process in SolidWorks generally starts in the part modeling environment, where we create the different parts that make the design of the product or machine, and are later assembled. In SolidWorks, every component of the design will be modeled separately, and each one is a single file with the extension *.sldprt. SolidWorks is a Feature based software; this means that the models are created by incrementally adding features to the model. Features are operations that either add or remove material to a part, for example, extrusions, cuts, rounds, etc. There are also features that do not create geometry, but are used as a construction aid, such as auxiliary planes, axes, etc.

This book will cover many different features to create parts, including the most commonly used tools and options. Some features require a Sketch or profile to be created first; these are known as Sketched features. The Sketch is the 2D environment where the sketch or profile is created. It is in the Sketch where most of the parameters and design intelligence is added to the design, including dimensions and geometric relations. Examples of sketched features include Extrusions, Revolved features, Sweeps and Lofts. Extrusions, Cuts and Revolved features will be covered in this book, while Sweeps and Lofts will not be covered, as they are generally considered more advanced modeling features.

A 2D Sketch can be created only in Planes or planar (flat) faces. By default, every SolidWorks Part and Assembly has three default planes (Front, Top and Right) and an Origin. Most parts can be started in one of these planes. It is not critical which plane we start our designs in; however, this selection will drive the default view orientations in the Part and Detail drawing environment. In the 2007 release it is easier to select the desired views when making a 2D drawing. The planning that takes place before starting to model a part is called the Design Intent.

SolidWorks is a 3D parametric mechanical design software. Parametric design means that the models created are driven by parameters. These parameters include dimensions, geometric relations, equations, etc. When any parameter is modified, the 3D model updates. Good design practices are reflected in how well the Design Intent and model integrity is maintained when parameters are modified.
Notes:
The Housing
When we start a new design, we have to decide how we are going to make it. Remember that the parts will be made one feature or operation at a time. It takes a little practice to define the optimum feature sequence for any given part, but this is something that you will master once you learn to think of parts as a sequence of features. To help you understand how to make the Housing part, we'll show a “roadmap” or sequence of features. The order of some of these features can be changed, but remember that we need to make some features before others. For example, we cannot round the corners if there are no corners to round! A sequence will be shown at the beginning of each part, and the dimensional details will be given as we progress.

In this lesson we will cover the following tools and features: creating various sketch elements, geometric relations and dimensions, Extrusions, Cuts, Fillets, Mirror, Hole Wizard, Linear and Circular Patterns. For the Housing, we'll follow the following sequence of features:

<table>
<thead>
<tr>
<th>Base Extrusion</th>
<th>Top Extrusion</th>
<th>Fillets</th>
<th>Inside Cut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front boss</td>
<td>Mirror Front boss</td>
<td>Side boss</td>
<td>Mirror Side boss</td>
</tr>
<tr>
<td>Front cut</td>
<td>Side cut</td>
<td>Screw hole</td>
<td>Screw hole pattern</td>
</tr>
<tr>
<td>Top tapped holes</td>
<td>Base hole</td>
<td>Base hole cut pattern</td>
<td>Mirror hole pattern</td>
</tr>
</tbody>
</table>
1. - The first thing we need to do after opening SolidWorks, is to make a **New Part** file. Go to the “New” document icon in the main toolbar and select it.

2. - We are now presented with the New Document dialog. If your screen is different than this, click the “Advanced” button in the lower left corner. Now select the “Part” template, and click OK, this way SolidWorks will know that we want to create a Part file. Additional Part templates can be created, with different options and settings, including different units, dimensioning standards, materials, colors, etc. See Appendix A for information on how to make additional templates and change the document **units** to inches and/or millimeters.
3. - Now that we have an empty Part file, we have to make a new **Sketch** to start modeling the part. Remember the sketch is the 2D environment where we start the profile before creating an extrusion. Since this is the first sketch of the part, SolidWorks will show us the three standard planes (Front, Top and Right) after selecting the “Sketch” icon for us to select the plane where we want to start.

4. - For the Housing, we’ll select the “Top Plane” to create the first sketch. We select the Top Plane, because we want to start modeling the part at the base of the Housing and build it up as was shown in the roadmap at the beginning of this chapter. The plane selection will determine the standard view orientations in the part and detail drawings. What we see in the Top view of the model will be the Top View in the drawing and so on.
When we make a sketch, we activate the **Sketch** environment. This is where we will create the profiles that will be used to make Extrusions, Cuts, etc.

SolidWorks gives us many indications, most of them graphical, to help us know when we are working in a Sketch.

a) The **Confirmation Corner** and the **Sketch** icon are activated.

b) The Status bar shows “Editing Sketch”.

c) In the Feature Manager “Sketch1” is added at the bottom just under “Origin,” and the plane selected is highlighted.

d) The part’s Origin is projected in the Sketch plane in red (which in this case coincides with the Origin because we are working in the Top Plane) and the grid is visible.

e) All the icons in the Sketch toolbar are activated.

f) The title bar of the SolidWorks window shows “Sketch1 of Part1”. This is the first sketch of the first part we make in this session of SolidWorks.

As the reader can see, SolidWorks gives us plenty of clues to help us know that we are working in a sketch.
5. - Notice that when we make the first sketch, SolidWorks rotates the view to match the plane that we selected. This is done only in the first sketch to help the user get oriented. In subsequent operations we have to rotate the view manually using the view orientation tools or the Middle Mouse Button.

6. - Select the "Rectangle" tool from the Sketch toolbar and click and drag in the graphics area to draw a Rectangle around the origin as shown. Don't worry too much about the size; we'll add the dimensions later.

7. - Notice the lines are in the color green after finishing the rectangle. The color green means the lines are selected. You can unselect them by hitting the Escape key. Now we will draw a "Centerline" from one corner of the rectangle to the opposite corner. The purpose of this line is to help us center the rectangle about the origin.
8. - SolidWorks indicates that we will start or finish a line at an existing entity with yellow icons; when the cursor is near an endpoint, line, edge, origin, etc. it will "snap" to it. Click on one corner, click in the opposite corner as shown and press the Escape key to finish the Centerline command as shown.

9. - Now we’ll select the “Add Relation” icon to add a “Midpoint” geometric relation between the centerline we just drew and the part’s origin. By adding this relation, the centerline’s midpoint will coincide with the origin, this way the part will be centered which will be useful in future operations.

10. - When the icon is selected, the “Add Relations” Property Manager is shown. The Property Manager is the area where we will make our selections and choice of options for most commands. Select the previously made centerline and the part origin by clicking on them in the graphics area (notice how they turn green and get listed under the “Selected Entities” box). Click on “Midpoint” under the “Add Relations” box to add the relation. Now the center of the line coincides with the Origin. Click on OK (the green checkmark) to finish the command. Click and drag a rectangle corner to see the effect of adding the relation.
11. - We just added a geometric relation manually, and we also added geometric relations automatically when we drew the rectangle and the centerline in the previous step. SolidWorks allows us to graphically view the existing relations between sketch elements. Go to the “View” menu, “Sketch Relations” if not already activated.

12. - Now we can see the geometric relations graphically represented by small blue icons next to the lines, arcs, etc. Notice that when we rest the cursor over a geometric relation icon, the entity or entities that share the relation are highlighted.

NOTE: To delete a geometric relation select the relation icon and press the “Delete” key, or right mouse click on the Geometric Relation icon and select “Delete”. (Do not delete relations at this time!)
The Sketch Origin defines the local Horizontal (Short red arrow) and local Vertical (Long red arrow) directions, this is important because we may be looking at the part in a different orientation, and vertical may not necessarily mean “up” on the screen. In SolidWorks we can add the following types of geometric relations between sketch entities:

- **Vertical** with respect to the sketch vertical direction (Long red arrow in the origin)
- **Horizontal** with respect to the sketch horizontal direction (Short red arrow in the sketch origin)
- **Coincident** is when an endpoint touches another line, endpoint, model edge or circle.
- **Midpoint** is when a line endpoint coincides with the middle of another line or model edge. A Midpoint relation implies Coincident; it is not necessary to add both relations.
Parallel is when two or more lines have the same inclination.

Perpendicular is when two lines are 90 degrees from each other, like vertical and horizontal lines.

Concentric is when two arcs or circles share the same center. Concentric can be also between a point or endpoint and an arc’s or circle’s center.

Tangent is when a line and an arc or circle, or two arcs or circles are tangent to each other.

Equal is when two or more lines are the same length, or two or more arcs or circles have the same diameter.

Collinear is when two or more lines lie on the same line.

13. - The next step is to add dimensions to the rectangle. Turn off the geometric relations display in the “View” menu “Sketch Relations” to avoid visual clutter in the screen. Click with the right mouse button in the graphics area and select “Smart Dimension” or select the “Smart Dimension” icon from the Sketch toolbar. Notice the cursor changes, adding a small dimension icon next to it to indicate to the user the Smart Dimension tool is selected.

14. - Adding dimensions in SolidWorks is very simple. Click to select the right vertical line and then click just to the right to locate the dimension. SolidWorks will show the “Modify” dialog box, where we can add the 2.625” dimension. Repeat with the top horizontal line and add a 6” dimension. As soon as the dimension value is accepted, the geometry updates to reflect the correct size.
NOTE: View the Appendix if you need to change the document’s **units** from millimeters to inches or vice versa. You can also override the units by adding “in” or “mm” at the end of the value in the Modify dialog box.

After dimensioning the lines, notice the lines change from Blue to Black. This is the way SolidWorks indicates that the geometry is defined, meaning that we have added enough information (dimensions and/or geometric relations) to define the geometry in the sketch. The status bar also shows “Fully Defined”. This is the preferred state before creating a feature, since there is no information missing and the geometry can be accurately described.
A sketch can be in one of several states; the three main ones are:

- **Under Defined**: (BLUE) Not enough dimensions and/or geometric relations have been provided to define the sketch. Sketch geometry is blue and can be dragged with the mouse.

- **Fully Defined**: (BLACK) The Sketch has all the necessary dimensions and/or geometric relations to completely define it. This is the desired state. Fully defined geometry is black.

- **Over Defined**: (RED) Redundant and/or conflicting dimensions and/or geometric relations have been added to the sketch. If an over-defining dimension or relation is added, SolidWorks will warn the user. If an over-defining geometric relation is added, delete it or use the “Edit” menu, “Undo” command or the “Undo” icon. If an over-defining dimension is added, the user will be offered an option to cancel it.

15. - Now that the sketch is fully defined, we will create the first feature of the housing; this is where we go from the 2D Sketch to a 3D feature. Select the “Extrude” icon from the Features toolbar, and change the options indicated below to extrude it 0.25”. Notice that the first time we create an extrusion, SolidWorks changes to an Isometric view, and gives us a preview of what the feature will look like when finished. To finish the command, select the OK button.
16. - After the first extrusion, notice that “Extrude1” has been added to the Feature Manager. The confirmation corner is no longer active. The status bar now reads “Editing Part” to alert us that we are now editing the part and not the sketch.

If we expand the Extrude1 feature in the Feature Manager by clicking on the “+” next to it, we see that “Sketch1” has been absorbed by the “Extrude1” feature.

17. - The second feature will be similar to the first one but with different dimensions. To create the second extrusion, we need to make a new sketch. When we select the Sketch icon, SolidWorks gives us a yellow message asking us to select a Plane or a planar face. We’ll select the top face of the previous extrusion for the next sketch. (If a Plane or flat face is pre-selected, the Sketch opens immediately in that Plane/face.)
18. - To help us get oriented, we will switch to a **Top View** to see the part from the top. In SolidWorks the user is free to work in any orientation, as long as he/she is able to see what they are doing. Re-orienting the part helps the new user get used to 3D in a more familiar way by looking at it in 2D.

19. - For the second extrusion, repeat steps 6 through 14 and dimension the rectangle 4” wide as shown.

20. - To define the sketch, we’ll add a **Colinear** relation between one of the blue lines and the horizontal edge of the previous extrusion. Select the “Add
Relations” icon from the Sketch toolbar and select the line and edge indicated. Then click in the “Collinear” relation and hit OK. This relation will fully define our sketch.

21. - We are now ready to make the second extruded feature. Select the Extrude icon as we did in step 15 and extrude it 3.625”. From the Standard Views icon, select the isometric view to see the preview of the second extrusion. Click on OK to complete the command.
22. - The next step is to round the edges of the two extrusions. To do this, we will select the **Fillet** command. This is what’s called an “Applied Feature”; we don’t need a sketch to create it, and it’s applied directly to the solid model. Select the “Fillet” icon from the Features toolbar and add 0.25” fillets to the corners indicated with the preview. SolidWorks highlights the model edges when we place the cursor on top of them to let us know that we’ll select them if we click on them. Click on OK when done selecting edges to complete the command.

**TIP:** If an edge or face is mistakenly selected, simply click on it again to de-select it. You can rotate the model using the arrow keys if you cannot see an edge.
23. - Repeat the fillet command to add a 0.125” fillet at the base of the Housing in the edges indicated in the next image.

In SolidWorks 2007, you can change the display of tangent edges (the edges where two tangent faces meet) by selecting the “View” menu, “Display” and then selecting the display option wanted: Visible, as Phantom, or Removed. Explore the different view options; Phantom is used in this book.
24. - We will now remove material from the model using the “Cut Extrude” feature. Switch to a **Top View** and select the top face, select the Sketch icon to add a new Sketch and add the geometry shown; this will be the area to cut. Notice that we can add dimensions from sketch geometry to model edges simply by selecting them. To add these dimensions, activate the Dimension command, click on a Sketch line, click on a model edge parallel to the Sketch line, and finally click to locate the dimension. Repeat to add the other dimensions.

25. - If needed, switch to a “Hidden Lines Removed” mode to view the model without shading as in the image above.
26. - In this feature, we will round the corners in the sketch using a **Sketch Fillet**. We can add the fillets as applied features like before, but in this step we chose to show you how to round the corners in the Sketch before making the “Cut Extrude” feature. Select the “Sketch Fillet” icon from the Sketch toolbar.

Set the fillet radius to 0.15”, and click on the corners of the sketch lines as indicated to round them. After clicking on all corners, click OK to finish the Sketch Fillet command. Notice that only one dimension is added. The reason is that SolidWorks adds an equal relation from all fillets to the one dimensioned.

27. - Now we will select the **Extruded Cut** icon to remove material. Opposite to the Boss Extrude feature that adds material, the Cut feature, as its name implies, removes material.
Make the cut 3.5” deep using the options shown in the next image. Change the view to Isometric and **Shaded with Edges** (Step 25) to better visualize the effect.

![Cut-Extrude](image1)

28. - In the next step we will add a simple round boss to the front of the Housing. Switch to a **Front View**, and make a sketch on the front face (we already know how to do this). Select the “Sketch” icon, and then click in the front most face. Or, the reverse order: select the face first, and then click in the “Sketch” icon.

![Front View](image2)

29. - Select the “**Circle**” sketch tool …

![Circle](image3)
... and draw and dimension a circle approximately as shown next. To dimension the circle, select either the center of the circle or its perimeter and the top edge of the housing.

30. - To locate the circle in the center of the part, we will add a **Vertical Relation** between the center of the circle and the part’s origin. SolidWorks allows us to align sketch elements to each other or to existing model geometry (edges, faces, vertices, etc.).
31. - After adding the **Vertical** geometric relation, extrude the Sketch 0.250". Notice the preview in the graphics area.

32. - The next step is to create an identical extrusion on the other side of the Housing, and to make it we will use the “**Mirror**” command to copy the one we just created. Switch to an Isometric view to help us visualize the Mirror’s preview and make sure we are getting what we expect.
33. - Select the Mirror command from the Features toolbar.

34. - From the Mirror Property Manager, we have to make two selections. The first one is the Mirror Face/Plane and the second is the feature(s) we want to mirror. The face or plane that will be used to mirror the feature has to be in the middle between the original feature and the desired mirrored copy. Creating the first extrusion centered about the origin caused the Front plane to be in the center of the part, making it the best option to use as the Mirror Plane. To select the Front plane, (make sure the Mirror Face/Plane selection box is in the color pink; this means that this is the active selection box) click on the “+” sign next to “Part1” to the right of the Property Manager to reveal a fly-out Feature Manager from where we can select the Front Plane.
35. - After selecting the Front Plane from the fly-out Feature Manager, SolidWorks automatically activates the “Features to Mirror” selection box (now in pink), and if not already selected, select the last extrusion to mirror it. Notice the preview and click OK. Rotate the view to see the mirrored feature.

36. - In the next step we'll add the small boss at the right side of the Housing. Switch to a Right View and insert a sketch in the rightmost face as shown. Remember to add a Vertical Relation between the center of the circle and the origin as we did in step 30.
37. - Now we are ready to extrude the sketch 0.5” to make the side boss.

38. - Just like we did with the front circular boss, Mirror the extrusion from step 37 about the **Right Plane**, which is also in the middle of the part. Use the fly-out Feature Manager to select the Right Plane and the previous Extrusion.
39. - We’ll now make the circular cut in the front of the Housing. Switch to a Front View and create a sketch on the front most face. Draw a circle using the Circle tool and dimension it 2.250” Diameter. To center the circle about the circular extrusion, add a “Concentric Relation” selecting the circle and the round edge. Click OK to finish the “Add Relations” command.

40. - Now that the circle is concentric with the boss, make a cut with the “Through All” option; this will make the cut go through the entire part regardless of its size. This way, if a previously added parameter changes the width of the housing, the cut will still go all the way across the part.
41. - We will now make a hole in the boss added in step 37 for a shaft. Switch to a right view and insert a sketch on the circular boss’ face. We want a hole to be concentric with the boss. To do this we can add the circle and a concentric relation as we just did; however, this is a two step process. Instead, we will do it in one step: Select the “Circle” tool icon from the Sketch toolbar and before drawing the circle, move the cursor and rest it on top of the circular edge as shown, until the center of the circular edge is revealed. DO NOT CLICK ON THE EDGE. This highlight works only if you have a drawing tool active like Line, Circle, Arc, etc.

42. - Start drawing the circle at the center of the boss to automatically capture a concentric relation with the boss and dimension it 0.625" diameter. Now the sketch is fully defined.
43. - Since this hole will be used for a shaft, we'll add a Bilateral tolerance to the dimension. Select the 0.625" dimension in the graphics area, and from the dimension's Property Manager, under “Tolerance/Precision” select “Bilateral”. Now we can add the tolerances. Notice that the dimension changes immediately in the graphics area. This tolerance will be transferred to the Housing’s drawing later on. If needed, tolerances can also be added later in the drawing.

44. - Now make a Cut with the “Through All” option to complete the feature.
45. - For the next feature we'll make a ¼"-20 tapped hole in the front face. SolidWorks provides us with a tool to automate the creation of simple, Countersunk and Counterbore holes, tap and Pipe taps by selecting a fastener size, depth and location. The “Hole Wizard” command is a two step process: in the first step we define the hole’s type and size, and in the second step we define the location of the hole(s). To add the tapped hole, switch to a Front View. This is a special type of feature that automatically creates the sketches needed, so there is no need to add a sketch first; it works like an applied feature.

**First**, select the front most face (where we want to put the tapped hole),

and then select the “Hole Wizard” icon. The order is very important; otherwise we'll have a different behavior when we define the location of the hole and more work will be needed to complete the feature.

46. - When the “Hole Wizard” dialog is presented, we'll define the hole’s type and size in the first step. Select the “Tap” hole specification icon, “ANSI Inch” for Standard, “Tapped Hole” for Screw type and “¼-20” for Size from their corresponding drop down selection lists. Change “End Condition” to “Up to Next” as indicated, this will make the tapped hole’s depth up to the next face where it makes a round hole.
47. - Now we are ready for the second step to define the hole’s location. Click in the “Positions” tab and notice the “Sketch Point” tool is activated automatically. When we pre-selected the front face, SolidWorks automatically added a point that locates the hole where we pre-selected the face, as we can see in the preview. In order to precisely locate the hole’s center, we will draw a centerline starting at the right quadrant of the outer circular edge, and finishing at the same quadrant of the inner circular edge. The quadrants will be activated after selecting the Centerline tool, and touching (not clicking!) the edge.
The idea behind this technique is to make sure the hole is centered in the circular face. Now add a “Midpoint” relation using the “Add Relation” icon and selecting the pre-existing point and the centerline we just made. Click OK to close the “Add Relations” dialog, and then click OK again to finish the Hole Wizard.

Hole location in the middle of the Centerline.

This is the finished “Hole Wizard” for the ¼″-20 Tapped Hole.
48. - After making the Tapped hole we decide that we want the walls of the Housing to be thinner, and need to make a change to our design. In order to do this, we find the feature that we need to modify in the Feature Manager, and make a click on it with the right mouse button. From the pop-up menu, select “Edit Sketch”. This will allow us to go back to the original sketch and make changes to it.

49. - What we just did was to go back to editing the feature's Sketch. Switch to a top view if needed for visualization. To change a dimension's value, double click on it to display the “Modify” box. Change the two dimensions indicated from 0.375” to 0.25” as shown.
50. - After changing the sketch dimensions we cannot make a Cut Extrude, because we had already made a cut with that sketch; what we have to do is to “Exit Sketch” or “Rebuild” to update the model with the new dimension values.

NOTE: There is no real purpose to this dimensional change but to show the reader how to go back to an existing feature’s sketch and make changes to it if needed.
51. - Once the first tapped hole is made, we need to add five more to complete the flange mounting holes. To do this we will make a Circular Pattern to copy the first hole in a circular pattern. Select the Circular Pattern icon from the Features toolbar.

52. - The Circular Pattern requires a model edge or axis to make copies about it. SolidWorks automatically adds an axis to every cylindrical face of the part, which means that we already have axes that we can use. To make these axes visible, go to the “View” menu and select “Temporary Axes”. (We can also control the visibility of other reference geometry from this menu). Notice that a blue axis is shown for every cylindrical face of the model.
53. - In the Circular Pattern’s Property Manager the “Parameters” selection box is active; this is where we select the axis to make the copies about. Select the axis in the center of the circular cut in the front face as indicated in the next image.
54. - Now click inside the “Features to Pattern” selection box to activate it. (Notice it turns pink.) Select the “¼-20 Tapped Hole1” feature from the fly-out Feature Manager, change the number of copies to six (NOTE: This count includes the original!) and make sure the “Equal spacing” option is selected to equally space the copies in 360 degrees. Notice the preview in the graphics area and click OK to finish the command. Now we can turn off the Temporary Axes the same way we turned it on.

55. - Since we need to have the same six holes in the other side of the Housing, we will use the “Mirror” command to copy the Circular Pattern about the Front Plane to add the same holes on the other side of the housing. Review the Mirror command from steps 33 and 38 if needed. Make the mirror about the Front Plane and mirror the “CircPattern1” feature created in the previous step. After the mirror, your part should look like this:
56. - We will now add four #6-32 tapped holes to the topmost face using the **Hole Wizard**. Switch to a Top View, and **select the top face**.

Then select the **Hole Wizard icon**.
57. - In the Hole Wizard’s Property Manager, select the “Tap” Hole Specification icon, and select the options shown for a #6-32 Tapped Hole; change the tapped hole’s depth to 0.75”. The “Blind” condition tells SolidWorks to make the hole a certain depth.

58. - Click in the “Positions” tab to define the hole’s location. Notice that the Sketch Point tool is active and a Point has already been added where the face had been pre-selected.
59. - With the “Point” tool active, touch (DO NOT CLICK!) on each of the other three corner fillets to show their centers, and add a point concentric to each fillet’s center. Add a Concentric relation between the first point and the last fillet. Click OK to finish the Hole Wizard.
60. - We are now ready to make the holes at the base of the housing. Go to a top view and make a new Sketch in the selected face. Draw a circle and dimension it, then make a Cut using the “Through All” option.

61. - In this step we will create a **Linear Pattern** of the previously made hole. A linear pattern allows us to make copies of one or more features along one or two directions (usually along a model edge). Select the Linear Pattern icon from the Features toolbar.
62. - In the Linear Pattern’s Property Manager, the “Direction 1” selection box is active; select the edge indicated for the direction of the copies. This is the direction the copies will follow. Any linear edge can be used for direction.

If the Direction Arrow in the graphics area is pointing in the wrong direction, click on the “Reverse Direction” button next to the “Direction 1” selection box.
63. - Now click in the “Features to Pattern” selection box to activate it and select the previous cut operation from the fly-out Feature Manager. Change the spacing between the copies to 0.75” and total copies to 3 (this value includes the original). Click OK to finish the command.

64. - To copy the previous linear pattern to the other side of the Housing, select the “Mirror” icon to mirror the Linear Pattern about the Right Plane to copy the holes.
65. - Add a 0.125” fillet to the indicated edges to finish the Housing as a finishing touch. Save the finished part as “Housing” and close the file.